
.. 2

.. 2
. 2
. 2
3
.. 4
6
. 6
6
. 6

7

9
9
10
10
10
1
1

READ ME FIRST

VXIPC  EMBEDDED CONTROLLER FOR VXWORKS
This document contains information to help you understand the 
components of your kit, determine where to start setting up your kit, 
and learn about the NI-VXI features.
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What Do You Have?
Your kit contains hardware, software, and documentation. You may al
have ordered some optional equipment or software.

Hardware
Your hardware includes either the VXIpc 800 Series or the VXIpc 700
Series controller, which you install in your VXI mainframe. You also 
receive the following accessories:

• 8 in. serial conversion cable (available for the VXIpc 800 Series on

• Electromagnetic emissions kit

• AT-PS/2 cable

Software
Your VXIpc kit contains the following software components:

• Host-Side Software for VXIpc for VxWorks 
(Microsoft Windows 95/NT Installation)

• NI-VXI for VXIpc 800/700 Series for VxWorks

• NI-488 for VXIpc 800/700 Series for VxWorks

For your convenience, NI-VXI and NI-488 are already installed on the 
hard drive of your VXIpc embedded controller.

Printed Documentation
Aside from this document, your kit contains the following printed manua

• Getting Started with Your VXIpc Controller for VxWorks contains an 
overview of the VXIpc hardware and the NI-VXI software, guides yo
through setting up your kit, and helps you get started with applicat
development. You can also use this manual as a reference for the
hardware and software default settings, to find the answers for 
commonly asked questions, and for information on reinstalling the
software, if necessary.

• The VXIpc 800 Series User Manual (in VXIpc 800 kits) or the 
VXIpc 700 Series User Manual (in VXIpc 700 kits) contains 
information on configuring and installing your VXIpc controller. 
You may not need this manual if you are performing a simple hardw
installation that uses the standard default settings. However, you 
should keep this manual in case you decide to try a different switc
or jumper setting at a later time. The user manual also contains 
information on BIOS, the front panel and connectors, the LEDs, a
system resources.
VXIpc Embedded Controller for VxWorks 2 © National Instruments Corporation
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• The GPIB Reference Manual for VXIpc Embedded Controllers and
VxWorks contains information about using NI-488 on your VXIpc 
controller with the VxWorks operating system.

Acrobat (Online) Documentation
Your kit includes manuals that are not in printed form, but in electronic
form: Adobe Acrobat version 3.0 portable document format (PDF) files
This online documentation is installed by the Host-Side Software for VXIpc
for VxWorks setup software and is intended for use on the Microsoft 
Windows 95/NT operating systems. This documentation is available fr
the Start menu, along with the NI-VXI online help, after you complete 
software installation on your host computer. You can view these manu
online, navigate through them, and print them from your computer usin
the Adobe Acrobat Reader 3.0 (or later version).

The Acrobat manuals are as follows:

• The NI-VXI User Manual describes the features and concepts of the
NI-VXI software and explains how to use NI-VXI in your 
application.

• The NI-VXI Programmer Reference Manual describes in detail the 
VXI/VME function calls in the C/C++ and BASIC languages.

To access the Acrobat manuals, the NI-VXI function reference, and 
ReadMe files, use the Start menu and go to Programs»NI-VXI for 
VxWorks .

If you do not already have Adobe Acrobat Reader 3.0 installed on you
machine, you can obtain the latest version directly from Adobe. Adobe
maintains a Bulletin Board Service (BBS), which you can use to uploa
files to Adobe Technical Support and download certain Adobe files. Th
number for the Adobe BBS is 206-623-6984. It is located in Seattle, 
Washington, which is in the Pacific time zone. If you live outside the 
United States or Canada, you are welcome to connect to the BBS, but
first want to try Adobe’s Web site (http://www.adobe.com/ ) or FTP 
site (ftp.adobe.com/ ), which may be accessible at a significantly lowe
connection cost.

Here are some tips on using PDF files efficiently:

• To view and print the online documentation, launch the Acrobat 
Reader and open the PDF documents. You can assemble your ow
printed documentation by printing either the entire document or on
the sections relevant to your application.

• To use hypertext links, click on any entry in the table of contents to
jump directly to that topic’s page. You can jump to major sections 
within each manual quickly and easily by clicking on the bookmark
© National Instruments Corporation 3 VXIpc Embedded Controller for VxWorks
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When you open your PDF documents, Acrobat displays the 
bookmarks. A bookmark with a triangle in front of it has bookmark
within it. To reveal the next level, click on the triangle. To collapse 
a higher level, again click on the triangle.

• You can change the magnification of the documents either by selec
the magnifying glass tool in the toolbar and clicking anywhere on t
manual page or by using the various options in the View menu.

• You can quickly find and go to every occurrence of any word or phra
in the entire document. Select the Tools»Find... option and type in the 
key word or phrase you want to find.

• The PDF file assigns consecutive numbers to each page throughou
document and displays this page number in the lower-left corner of
Acrobat window. When you choose the View»Go To Page... option or 
are printing pages, you must use the page numbers in the lower-le
corner of the window, not the number displayed at the bottom cente
each manual page or listed in the contents and index. The numbe
shown in the bottom center of the page is for printed documents o

Where Do You Start?

1. Compare your kit contents with the description in the preceding What 
Do You Have? section. Contact National Instruments regarding any
discrepancies.

2. VxWorks uses a target and host machine. If you are unfamiliar with 
this concept, refer to the Developing for VxWorks section in Chapter 1, 
Introduction, in your getting started manual. 

3. The following steps assume that VxWorks is already installed on 
your host computer. Run the Setup program from the Host-Side 
Software for VXIpc for VxWorks installation disk to install the 
software. This disk is intended for Windows 95/NT host machines. 
For a first time installation, we recommend that you install all of th
software, which contains the VxWorks Board Support Package (BS
the VXI/VME and GPIB driver component software, online help, 
examples, and header files for NI-VXI and NI-488.

4. Refer to the Using the VXIpc Board Support Package to Create the
VxWorks Operating System section in Chapter 1, Introduction, in 
your getting started manual. This section contains information abo
building the VxWorks operating system, which will run on the VXIpc
This section also contains information about configuring the VXIpc
boot parameters, the VXIpc MITE window, and the VXIpc 
peripherals—Ethernet, SCSI, and IDE.
VXIpc Embedded Controller for VxWorks 4 © National Instruments Corporation
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5. On the target side, your VXIpc should have the NI-VXI and NI-488 
software already installed. 

a. If you need to reinstall the NI-VXI software for any reason, us
the disk labeled NI-VXI for VXIpc 800/700 Series for VxWorks. 
You can also refer to the Reinstalling the NI-VXI Software section 
in Chapter 1, Introduction, of Getting Started with Your VXIpc 
Controller for VxWorks. 

b. To reinstall the NI-488 software, copy the files from the disk 
labeled NI-488 for VXIpc 800/700 Series for VxWorks to the 
VXIpc hard drive. 

6. Most VXI/VME features on the VXIpc controller are configurable 
through software. Use the vxitedit configuration utility in the NI-VX
software if you want to change any of the options from their defau
settings. Also run resman to set up your VXI system and victext to
verify the system configuration.

7. After you finish setting up your system, refer to the following 
documents to learn how to use VXI/VME or GPIB.

a. Refer to Chapter 4, Developing Your Application, in your getting 
started manual to learn how to use your VXI/VME system and
ensure it is operating properly. 

b. Refer to Chapter 2, Developing Your Application with the 
VxWorks Drivers, in the GPIB Reference Manual for VXIpc 
Embedded Controllers and VxWorks to learn how to use the 
VxWorks GPIB drivers and how to develop a GPIB application
using the NI-488 API.

8. Please refer to the README.TXT file for important NI-VXI information 
that may affect your application program, including known issues a
software corrections with this release and additional information 
relevant to NI-VXI API development. You can access the 
README.TXT file, in addition to the NI-VXI online help and Acrobat
manuals, through Start Menu»Programs»NI-VXI for VxWorks . 

To access the README.TXT file for NI-488 information, go to the 
directory where you installed the NI-488 software for VxWorks on 
your host machine.

You can also reference the National Instruments sites 
http://www.natinst.com  or ftp.natinst.com  for driver 
updates, examples, and product news.
© National Instruments Corporation 5 VXIpc Embedded Controller for VxWorks
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What Is NI-VXI?
The NI-VXI system-level software is the driver that controls your VXIp
and VXI/VME system. NI-VXI includes a Resource Manager, an 
interactive configuration program, libraries of software routines for tes
and measurement programming, and an interactive control program. 
You can use this software to seamlessly program multiple-mainframe 
configurations and ensure software compatibility across a variety of 
controller platforms.

NI-VXI Release Notes
This section describes the new utilities and features in this release of 
NI-VXI for VxWorks.

Supported Application Development Environments
This release of NI-VXI for VxWorks supports the Tornado gcc compile
version 2.7. Although NI-VXI has been tested and found to work with th
Application Development Environment (ADE), other ADEs or a later 
version of this ADE may also work.

New Features and Terminology
New functionality has been added to NI-VXI in four major areas to expl
features in the MITE ASIC. These features are as follows:

• Window mapping

• MITE DMA

• Shared memory

• Remote controllers

The NI-VXI Directory
The nivxi  directory on your VXIpc hard drive contains important files 
that describe the configuration of your hardware and software. By defa
the library searches for these files in the directory /ide0/nivxi , which 
corresponds to C:\NIVXI  in MS-DOS and means that the nivxi  directory 
must be at the root level of the hard drive. If, for some reason, you mu
move or rename the directory, use the environmental variable NIVXIPATH  
to inform the library of the new location. The VxWorks method for settin
an environment variable uses the putenv("variableName=value")  
function. For example, to instruct the library to search for the NI-VXI file
in a subdirectory of your NI-VXI directory, your function syntax would b
putenv("NIVXIPATH=/ide0/nivxi/vxworks") .
VXIpc Embedded Controller for VxWorks 6 © National Instruments Corporation
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Window Mapping
The MITE architecture allows much more flexibility in low-level mappin
of VXI address spaces. In particular, the CPU interface of the MITE ha
windows that can be dynamically resized and relocated from CPU spac
VXI space. The low-level functions have new extensions that reflect th
feature. Refer to the NI-VXI online help or the NI-VXI Programmer 
Reference Manual for information about these functions in NI-VXI. As 
mentioned earlier in this document, you can use the Acrobat Reader 3
to view and navigate through the NI-VXI manuals.

As in earlier versions of the drivers, the MapVXIAddress()  function 
checks whether a window that can be shared already maps to the des
address space and location. If so, it returns a pointer to that window. If
desired space is not already mapped, it sets up a new MITE window to
VXI address and returns a pointer to the new window. 

The MapVXIAddressSize()  function is the standard mechanism for 
specifying how large a window the driver should map on a call to 
MapVXIAddress() . The default size of a mapped window when using 
NI-VXI is 64 KB.

The success of this allocation depends on the availability of three facto

• Address space in the user window

• Number of MITE windows

• Memory for allocating data structures for the map

The MITE has two windows that must be set up in the VxWorks operat
system. The driver window has a fixed size and, unless you change th
hardware in your VXIpc, you probably should not alter this window. Th
user window defaults to 64 KB. 

If you need a different user window size, perform the following steps:

1. Change the user window size field in the vxitedit Bus Configuration 
Editor.

2. Change the VxWorks image by modifying the sysLib.c  file to match 
the user window size you specified in vxitedit. Refer to the Mapping 
the MITE Windows section in Chapter 1, Introduction, in your getting 
started manual for more information. 

3. After you make these changes, recompile the operating system.
© National Instruments Corporation 7 VXIpc Embedded Controller for VxWorks
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Address Space
The VXIpc controller can decode any 32-bit address on the PCI bus a
VXI cycle, giving 4 GB of addressability, which can be used for window
on the VXIpc. The operating system or computer architecture may lim
which addresses can be assigned to the VXIpc. 

To change the address space, use vxitedit to edit the user window size 
field in the VXIpc Bus Configuration Editor . This setting limits the total 
amount of memory you can map with MapVXIAddress() . If the user 
window is disabled, the MapVXIAddress()  function returns 
NO_HARDWARE_SUPPORT (-1) .

The NI-VXI Programmer Reference Manual implies that the error code 
MAP_TIMEOUT (-8)  is returned when the window is in use. Because th
MITE-based products have multiple hardware windows of variable size
the meaning of this error has been modified. MapVXIAddress()  now 
returns the error code MAP_TIMEOUT (-8)  whenever there are not enough
resources to map the window.

For example, if you use MapVXIAddressSize()  and MapVXIAddress()  
to request a 1 MB window to A32 space and you request a user windo
of only 64 KB, MapVXIAddress()  returns the error code MAP_TIMEOUT 
because there are not enough resources to complete the request.

Number of MITE Windows
The MITE has eight CPU windows. NI-VXI uses four of these windows
leaving four for user applications.

Memory for Allocating Data Structures
You need to have sufficient memory available to set up the necessary 
tables. If you request a very large window—hundreds of megabytes, f
example—you may run out of memory.

MITE DMA
The MITE has two DMA channels to improve the throughput of block 
transfers to and from the VXI system. The DMA channels can use vari
high-speed bus protocols, such as the following:

• VXI block 

• Burst mode (on the PCI bus)

• VME64 (on the VXI bus)
VXIpc Embedded Controller for VxWorks 8 © National Instruments Corporation



us 
s 

e 

cols 
 

n 
.

uld 
re 

ces 
 an 

e 
t 

g 

ch as 
h 
ese 
The DMA channels can transfer data between a VXI device and local 
memory, or between VXI devices. The DMA channel can handle 
contiguous or noncontiguous local memory. If it is handling noncontiguo
memory, it can perform scatter-gather operations on the noncontiguou
memory.

The VXImove()  function automatically uses appropriate bus protocols 
and transfer types to efficiently perform the data transfer specified in th
function. You can also configure the NI-VXI software to use DMA 
channels for particular types of operations and to designate what proto
the channel should use. In addition, you can programmatically control
which protocols to use in NI-VXI. See the NI-VXI online help or the 
NI-VXI Programmer Reference Manual for complete descriptions of 
VXImove()  and other high-level functions. Notice that previously writte
NI-VXI code uses the DMA capabilities of the MITE without modification

To take full advantage of the throughput of the DMA channels, you sho
perform 32-bit transfers in which both the source and the destination a
longword aligned. If you need to transfer character data between devi
of different byte orders—for example, between a big-endian device and
Intel 80x86-based VXIpc—transfer the data as longwords but adjust th
byte-ordering parameters in VXImove()  to get the correct data in the mos
efficient manner.

Examples:

/* Transferring 32-bit data to a big-endian A32 device */

VXImove(0x0, userBuffer, 0x3, deviceOffset, numDataPoints, 4);

/* Transferring 8-bit data to a big-endian A32 device */

VXImove(0x80, userBuffer, 0x3, deviceOffset, numDataPoints / 4, 4);

Shared Memory
The Logical Address Editor includes options you can use to share 
memory on your computer. Consult the NI-VXI online help or your gettin
started manual for more information. You can use the VXImemAlloc()  
function to access shared memory on your computer.

Remote Controllers
This section applies to multiframe systems where you use interrupts, 
triggers, or utility bus signals.

Remote controllers, when configured to detect asynchronous events su
a VXI interrupt or VXI trigger, need to inform the local controller that suc
an asynchronous event has occurred. The remote controllers report th
events back to the local controller via a VXI IRQ line. This IRQ line is 
called the system IRQ line. You can use vxitedit to select which VXI 
© National Instruments Corporation 9 VXIpc Embedded Controller for VxWorks
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interrupt line the remote controller uses to report remote events to the l
controller. Map the system IRQ line back to the local controller to rece
remote controller interrupts. The Resource Manager performs this map
automatically in the parent-side VXI-MXI-2 controllers, but not in other
mainframe extenders. You can map interrupts through vxitedit, or with 
MapVXIint()  function, which is described in the NI-VXI online help or
the NI-VXI Programmer Reference Manual.

The system IRQ line is treated differently than other IRQ lines used by
NI-VXI:

• The Resource Manager (Logical Address 0) always acknowledges
system IRQ line.

• You cannot disable the system IRQ line on the Resource Manage
Calling DisableVXIint()  on the system IRQ line does not disable it.

• Devices other than remote controllers can also interrupt on the sys
IRQ line, provided the device at Logical Address 0 is the handler f
the interrupt.

• National Instruments recommends that you do not route the system 
IRQ line to the signal queue. Because the system IRQ line cannot
disabled, this routing could lose interrupts.

Passing the value –1 as the logical address of a controller in NI-VXI cau
NI-VXI to select the local controller. Notice that on external controllers 
such as the PCI-MXI-2, –1 refers to the first remote controller in your 
system. This is to maintain compatibility with older systems where the
external controller needed an extender to assert and receive interrupts

Enhancements to the NI-VXI Software
The following sections describe the additional options beyond what is 
documented in the NI-VXI User Manual and the NI-VXI Programmer 
Reference Manual.

Compatibility
NI-VXI applications that follow the guidelines documented in the 
NI-VXI User Manual will work with NI-VXI for the VXIpc embedded 
controllers.

System Configuration Functions
The InitVXIlibrary()  function has a new return value of 
INIT_RET_OK_RMERROR (2) . If this value is returned, it means 
“The NI-VXI library successfully initialized, but the Resource Manager
has not been run successfully.” Always run the Resource Manager be
using the NI-VXI library.
VXIpc Embedded Controller for VxWorks 10 © National Instruments Corporation
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Low-Level VXIbus Access Functions
Do not make any assumptions about the size and features of a windo
returned from MapVXIAddress() . Use GetWindowRange()  to determine 
the size of a window.

The 32-bit value returned from GetContext()  and passed to 
SetContext()  has a new format. Applications that set the context bits
directly for use in SetContext()  may not be compatible with the new 
format for context. Because the MITE allows more flexible window 
mapping, extra bits have been added to this field to reflect these new 
features. Do not manipulate the context bits directly.

High-Level VXIbus Access Functions
For best performance, keep the following in mind when using VXImove() :

• Make sure your buffers are 32-bit aligned.

• Transfer 32-bit data whenever possible.

• Using VXI block access privileges significantly improves performan
to devices that can accept block transfers.

• VXImove()  must lock the user buffer in memory on virtual memory
systems, so locking the buffer yourself optimizes VXImove() .

• Because VXImove()  must build a scatter-gather list for the user buffe
on paged memory systems, using a contiguous buffer optimizes 
VXImove() .

VXImemAlloc()  returns 32-bit aligned, page-locked, contiguous buffer
which work efficiently with VXImove() , but only if the function returns 
MEM_OK (0) . A status of MEM_OK_USE_MEMCOPY (1)  means this buffer 
cannot be used directly with VXImove() .

VXImove()  can also move blocks of data to and from a single VXI addre
This is commonly referred to as FIFO mode. Refer to the NI-VXI 
Programmer Reference Manual for more information.
© National Instruments Corporation 11 VXIpc Embedded Controller for VxWorks
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